Textus
Textus
Live
Live
with layers

Sporting events titling software

2017
2017

Textus Live
Table of content

Starting the software package
Important
Layers support software Textus Control Panel
TextusControlPanel software function keys
BlackMagic Design settings
Sporting events titling software Textus Live
The concept of layers
Using layers

3
4
5
7
8

Loading templates (Open)
Creation of new project (New Project)
Project‘s loading (Open Project…)
Project‘s saving (Save Project…)
Project‘s saving with new name (Save Project As…)
Quit (Exit)

11
12
12
12
12
12

10
10

File

Window
Next window (Next)
Close window (Close)
Redrawing title (Redraw)
Reloading window (Reload)
Preview window (Preview…)
Edit the template (Edit…)
Shortcuts of the active window (Activate Shortcut…)
Shortcuts on air (On Air Shortcut…)
Setting colors (Color…)

13
13
13
13
14
14
14
14
15

On Air
Active window on air (Title On Air)
Clock on air (Clock)
Reading data (Get Data)
Preview mode
On / off title (Enabled/Disabled)

Videotekstas

16
16
16
16
16

1

Layer settings
Live video as title on air (Clock from camera)
Quick roll (Roll…)
Quick crawl (Crawl…)

17
17
17
18

Change the font (Font)
Setting colors (Colors)
Symbol (font) attributes settings (Attributes)
Selection of type (Type)
Format of clock (Format)
Control of timer (Revers)
Stop and start the timer (Timer) (stop/move)
Clock’s background (Background)
Positioning clock (X, Y)
Settings the timer (Timer Time)
Timer’s start time setting (Start Time)
Font size (Font Size)
Layer settings
Setting time (Set Time…)
Timer‘s Stop/Start (Timer)

19
19
20
20
21
21
21
22
22
22
22
23
23
23
23

Clock

Options
Setup (Setup)
Setting text encoding (Encoding)
Global field data setting (Data Setup)
Set the color of the screen (Screen Color…)
On air effects

Function keys (Help)
Abbreviations, database records (FootballStatistic)
Abbreviations, database records (BasketballStatistic)
Digital clock over network

Videotekstas

24
25
26
27
27

28
29
30
31

2

Starting the software package
To start the program, run two file: TextusControlPanel.exe and
TextusLive.exe directly or click on the icons:

Textus Control Panel software will start automatically when TextusLive
is starting if it is in the same directory as the program TextusLive. If not, then you
need to run it manually.

Textus Control Panel
Windows Taskbar

program

automatically

is

located

in

the

Textus Control Panel running automatically disables single layer Textus
programs Title output preview option to Disable.
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Important:
Change default Windows register data for TEXTUS LIVE software to
increase used templates number in project:
1.START\RUN\regedit

2. Find
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurentVersion\Windows\
3. Change these settings
GDIProcessHandleQuota – change to 4e20(20000)

USERProcessHandleQuota – change to 4e20(20000)

4. RESTART COMPUTER !
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Layers support software

Textus Control Panel
Clicking on the red button, the title is turned off that layer.
Clicking the right mouse button on Textus Control Panel window
appears menu with functions:
Device Settings (Alt+S) - select this function to set Textus Air
parameters:

Video Device - video device (DeckLink Video Render);
Format - format of video signal:
SD(576x720) mode - PAL 576i;
HD(1080x1920) mode - HD 1080i.
Audio Device - audio device (DeckLink Audio Render);
Keying Control - keying mode of card:
Off - off. Title can‘t be keyed. No signal DSK KEY;
Internal - internal keying. Title is keyed inside DeckLink card;
External - external keying. Title is keyed on the external switcher with
DSK FILL, DSK KEY signals from DeckLink card.
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Aspect Ratio - aspect ratio 4x3 or 16x9 for SD mode (PAL576i) only;
Title output - on air preview mode:
Disabled - preview only on the Textus Control Panel screen;
Secondary Monitor - preview on the secondary monitor. To use this
mode set computer‘s graphic board into Dual View.

Reference Output Timing - horizontal timing off output signals
(horizontal position of the title);
Alpha Position - Alpha signal’s positioning relative to the signal Fill to
keying tite through DSK in analog mixers. This function works only in External
mode;
Mixing field:
Level - title transparency for the all screen (0-no title, 100 – fully
keyed title, no transparency);
Mixing time - title mixing time (video frames).
External Mixing field:
Level - indicates mixer’s level when HD/SD Bypass board with mixer
fader is used;
Serial Port COM port number for the HD/SD BYPASS board with
mixer fader controlled via a serial COM port;
Mirror - all titles are mirrored for prompting option;
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There is additional parameter Remove First Pixel. Selecting this function
(), the first pixel of each row is eliminated, due to the issue of the DeckLink
Studio board. After unmarking, the first pixel is displayed as is;
Start Service/ Stop Service - start/ stop the Decklink card and bypass
block management service. There is no output from DeckLink card and bypass
block is in the BYPASS mode if the service is not started.
Make the necessary settings and press  in the lower right corner of
setup window.
Disable/Enable Output (F9) - on/off title. To on/off all layers on the air,
select a title function Enabled or press a F9. Red mark on
the Textus Control Panel screen indicates that all layers
are off of the air. To off air each layer can be
performed by pressing buttons by mouse.
Layers (Layer0, Layer1,…Layers3) can be renamed to the desired
names. Click right mouse button on the layer key (Layer0, Layer1,…Layers3),
choose function Rename and assign new Layer Name (visible on the
Textus Control Panel) or Short Name (visible on the software layer’s button).
GPI Device Setup (ALT+G) - settings for GPI.
 Device 1 or  Device 2 - titles and logos boxes can
be assigned to the buttons of external remote control
panel. Select the serial port COM (RS232) on your
computer, which is connected to the external control
panel;
Hide - hide the TextusControlPanel software from the Desktop. It is
active on the Taskbar;
Zoom 1:1 Original (ALT+Z) - actual preview screen size depending on
the Format and Aspect Ratio. Size can by adjusted manually;
Zoom 1:2 Half (ALT+H) - half of actual preview screen size. Size can by
adjusted manually;
Close (ALT+F4) - Textus Control Panel software closing. No title on the
air in any case.

Textus Control Panel software function keys
Function keys speed up your work. You can use them to cause some
major and frequently used functions, without going into the menu.
Alt+S
- device Settings;
F9
- on/off title;
Alt+G
- settings for GPI;
Alt+Z
- actual preview screen size depending on the Format
and Aspect Ratio;
Alt+H
- half of actual preview screen size;
Ctrl+Alt+T - additional information;
Alt+F4
- Textus Control Panel software closing.
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BlackMagic Design settings
In Settings sheet:
! Is necessary to off Remove field jitter when video is paused and set
fields:
Set default video standard as: PAL or HD1080i 50 (determines in
which mode is DeckLink card just after computer switch on until Textus software
will runs. Usually: for SD - PAL, for HD - HD1080i 50);
When not playing video, send: Last Played Frame.

Videotekstas

8

In Processing sheet:
Select output processing:
Select input processing:
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Sporting events titling software

Textus Live
The software package TEXTUS LIVE designed for live titling of sport
events. It uses the templates and titles, previously prepared with the software
package TEXTUS EDITOR.

The concept of layers

All layers are summed over the alpha channel. Layer 0 has the lowest
priority, and Layer 3 - the highest. Titles, effects and control of each layer are
independent of the other layers.

Using layers
Each window of the Textus Live own a layer number Layer 0, Layer 1,
Layer 2, Layer 3. To select a layer, press the button in the lower right corner of
window. Layer can be changed at any time.

Videotekstas

10

FILE
To work with files, that contain predefined templates, designed the menu
item File.

Loading templates (Open)
To load the template select Open from the File menu or press F4. A
window opens with a list of existing templates *.pgw.
Choose the drive and directory, select the template you want, and press
Open. The template file is loaded.

The template fields will be filled with data from database if the statistic
database for this pattern exists.
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Creation of new project (New Project)
Select New Project function in File menu to create new project.

Project‘s loading (Open Project…)
Choose Open Project… function in File menu. A window opens with the
list of existing projects *.ini.
Set to the desired drive and directory, select the project and press Open.
Project will be loaded into and you can continue to work with him.

Project‘s saving (Save Project…)
To save changes into existing file, use Save Project…. The file will be
rewritten.
For a new project open Save Project As…. Set to the desired directory,
type in the new name of project and click the Save button in the window or press
the Enter key on keyboard.

Project‘s saving with new name (Save Project As…)
To name and save a new project, as well as to maintain the existing
project under a new name, select a function Save Project As.... When selected,
the window Save As opens for entering the name of project.

Quit (Exit)
To quit the software package TEXTUS LIVE select Exit from the File
menu or simultaneously press the "Alt" and "X".
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WINDOW
Main menu item Window is designed to work with windows of templates.

Next window (Next)
Select Next in the Window menu or press F6 to move from one window
box to another. Switch from one window to another take place in order of opening
windows.

Close window (Close)
To close active window select Close from the Window menu or
simultaneously press "Ctrl" and "F4".
The same action can be performed in the active window by pressing
Close, or by right mouse button clicking and selecting the Close in the menu.

Redrawing title (Redraw)
You must update the title’s data manually, if data from statistic database
auto validation is turned off. Select Redraw in Window menu, or simultaneously
press "Alt" and "Z", and the title will be redrawn on the air.
The same action can be performed in the active window by right mouse
button clicking and selecting the Redraw in the menu.

Reloading window (Reload)
When you edited the template (fill the fields, removed something, write
text over the other…), then after that is it needs to update the window new
changes were to be introduced. To do this, click Window function Reload, and the
template window will be redrawn.
The same action can be performed in the active window by right mouse
button clicking and selecting the Reload from the menu.
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Preview window (Preview...)
Select the Preview... function in the Window menu or simultaneously
press the "Alt" and "P", for title’s preview on the computer’s monitor.
The same action can be performed in the active window by right mouse
button clicking and selecting the function Preview... or pressing on
the active window.

Edit the template (Edit...)
Select menu Window function Edit... to edit a previously created
template. Editor Textus Editor will be opened with template, and you can edit the
template.
The same action can be performed in the active window by right mouse
button clicking and selecting the Edit... function.

Shortcuts of the active window (Activate Shortcut...)
To activate the window quickly, you can
assign a hotkey for each window. Choose
Window function Activate Shortcut.... In the
window Hot Key type the desired key
combination, for example, press Alt and F2.
The same action can be performed in the
active window by right mouse button clicking and
selecting function Activate Shortcut....

Shortcuts on air (OnAir Shortcut...)
To display the information of the template
on the air quickly, you can assign a hotkey for
each window. Choose Window function
OnAir Shortcut.... In the window Hot Key type
the desired key combination, for example, press
CTRL and digit 2.
The same action can be performed in the
active window by right mouse button clicking and
selecting function OnAir Shortcut….
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Setting colors (Color…)
For window color settings select Color... from the menu Window. Once
the desired color is selected, the active window will be assigned to a new color.

The same action can be performed in the active window by right mouse
button clicking and selecting function Color... from the menu.
In Define Custom Colors are the values of level RGB A signals. The
values range is from 0 to 255. Changing values of each field, you set the color. R
change the color of red component, G - the color of green component, B - the
color of blue component, A - the transparency level of color.
Window Custom colors intended for custom selected colors. In the
window Custom colors click any square with mouse, in the colors - the desired
color, select function Add to Custom Colors and press Ok. The selected color
will be assigned to the selected square and stored until the next change.
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ONAIR
Menu On Air is designed to display the desired window on the air with
the data.

Active window on air (Title On Air)
Select function Title On Air in the menu On Air or simultaneously press
the "Alt" and "A" to display title of the active window on the air.
The same action can be performed in the active window by pressing
On Air button.

Clock on air (Clock)
Select Clock on the menu On Air or press a F5, to display clock on the
air.

Reading data (Get Data)
Function is designed to read data from the database into the active
window. To do this, select Get Data on the menu On Air or press a F8. This
function does not work, if the window is in the automatic reading mode of data.
Fastest way to get data of desired player is to find by his number: type
number into nr box simply.

Preview mode
Off function
of each layer allows you to preview title on the
TextusControlPanel window without be on air. This shows a flashing layer button
on the Textus Control Panel. Function on/ off
applies
to
all
templates contained this layer.

On/off title (Enabled/Disabled)
To on/off all layers on the air, select a title
function Enabled Output in On Air menu or press a
F9. All layers off the air indicated by red mark
on the TextusControlPanel screen. To off
air can be performed by pressing On Air button by
mouse in the active window also.
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Layer settings
Each titling file is assigned to a layer by selecting
layer on the template window.
All layers are summed over the alpha channel.
Layer 0 has the lowest priority, and Layer 3 - the highest.
Titles, effects and control of each layer are independent of
the other layers.

Live video as title on air (Clock from camera)
In the template *.pgw a function V1, V2, V3, V4
is designed to display live video on the air from a video
input. Basically, this feature is intended to show the time
of scoreboard’s clock from the camera.
Preparing a template in the Textus Editor, with
function Insert Field... is created a special field:
parameter Source is assigned
with
values
@ LiveVideo1,
@ LiveVideo2,
@ LiveVideo3,
@ LiveVideo4. Function V1 includes a window that
describes the parameters
@ LiveVideo1, V2 parameter
@ LiveVideo2,
V3
parameter
@ LiveVideo3, and V4 - parameter @ LiveVideo4.
Buttons V1, V2, V3 and V4 turns on/off on air live clock
video.

Quick roll (Roll…)
To scrolling titles select Roll... in menu On Air. A window opens with the
list of existing titles in the format *.pgw. Select the desired directory, title file and
press Open. The file will be loaded.
Enter the desired speed from 1 to 9 in the Title Roll function. Click Move
or F8 and title to begin scrolling up.
When issuing a title on the air, motions speed is controlled by and PgDn.
Use the PgUp to and PgDn – to decrease within one step. While scrolling title is
on the air, you can stop and restart the movement by pressing F8.
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Quick crawl (Crawl…)
To crawl titles select Crawl... in menu On Air. A window opens with the
list of existing titles in the format *.pgw. Set directory, title file and press Open.
The file with crawl titles will be loaded.
Enter the desired speed from 1 to 9 in the Title Crawl function. Click
Move or F8 and title begins crawl left.
When issuing a title on the air, motions speed is controlled by PgUp and
PgDn. Use the PgUp to increase in the template *.pgw speed and PgDn – to
decrease within one step. While crawl title is on the air, you can stop and restart
the movement by pressing F8.
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CLOCK
Select a function Options... in menu Clock to change the digital clock.
Window Time Settings opens and then set the options you want.

Change the font (Font)

Select menu function
Font... in menu Font or press
F3. This will opens the Font
dialog box with a list of names
of existing True Type fonts.
Select the desired font.
Set style, the font size and
language, then press Ok in the
window, and the clock’s font will
be changed.

Setting colors (Colors)
To set the color of the symbol and its attributes is used the menu function
Colors. Colored small boxes next to the names of attributes show their current
color. Colors can be chosen from a palette of 16.7 millions. The symbol’s top color
from the palette is selected by pressing left mouse button on the upper portion of
the symbol’s color rectangle, and the bottom color - the same left mouse click on
the bottom of rectangle. Top and Bottom colors value is indicated by text info on
the symbol’s color rectangle.
Mark the function () Solid if the color must be monochrome.
On the right side of the window are the values of level RGB A signals.
The values range is from 0 to 255. Changing values of each field you set the color.
R change the color of red component, G - the color of green component, B - the
color of blue component, A - the transparency level of color.
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Setting any level of transparency the black-and-white background’s
squares shows the future transparency in the output channel (on air).

Window Custom colors intended for preset 14 custom selected colors.
Set the desired color and then by right mouse button clicking on the
Custom colors any square and select Set. Selected color will be assigned to the
square and stored until the next change.

Symbol (font) attributes settings (Attributes)
To set the attributes of the character use the main menu item Attributes.
In the Attributes function, next to the attribute’s name, specifies parameter is set
(√) or not ( ). When selecting the desired attribute mouse clicking change
attribute’s setting to the opposite.
Shadow Offset and Shadow Drop attributes is inconsistent, therefore
they can’t be set simultaneously. When specifying a single attribute, the other is
automatically canceled.
Border Size, Shadow Size can be selected of values from 1 to 20.
Select the desired value.

Selection of type (Type)
Clock or timer can be on air. To switch the clock’s type select function
Type in menu Time:
Clock - clock;
Timer - timer.
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Format of clock (Format)
It is possible to show only a part of the digital clock or specify time format.
To do this, use the menu Time function Format. Select the desired format.
Format mmm:ss designed to display the time, for example in soccer
(football): game time 01:25:20 will be displayed as follows: 85:20.

Control of timer (Revers)
In menu Time select Revers function to switch timer into reverse mode.
 Revers - time will be counted backward;
Revers - time will be counted forward.
Timer can be considered as forward or backward. Timer is counting up to
24 hours then drops to zero in forward mode. Backward timer is counting down
from the desired value to 0 and then counting stops.

Stop and start the timer (Timer) (stop/move)
Function Timer is designed to stop/run timer. If the timer, at the moment
you go on air, must to counts then set () Move. In case you start timer directly on
air, value must to be () Stop.

Videotekstas

21

Clock’s background (Background)
The clock’s background can be filled with a color or graphic pattern with
function Background.
To set picture on the background, select Set Picture.... This will opens
the Open dialog box with a list of existing graphics. Select the image and press
Open or Enter key on the keyboard. The selected image will be displayed on the
Background and filled the clock’s background.
To fill the background by color, click the Set Color.... Set () Solid if the
clock has to be monochrome. It is possible to set color’s gradient for background.
The background’s top color from the palette is selected by pressing left mouse
button on the upper portion of the symbol’s color rectangle, and the bottom color the same left mouse click on the bottom of rectangle. Top and Bottom colors
value is indicated by text info on the symbols color rectangle. Make the necessary
settings and select Exit or press √ in the lower right corner of color’s function
window.
Clock (timer) will be automatically turned off when you on aired title on
the same layer as clock.

Positioning clock (parameters X, Y)
Enter desired coordinates X and Y into the respective boxes on the
clock’s main menu. The position of the clock can be controlled with the mouse by
moving the clock to the desired place.

Setting the timer (Timer Time)
Fulfill Timer Time box on the clock’s main menu with values to set the
initial value of the timer.

Timer’s start time setting (Start Time)
Start Time box is used to set timer’s starting time, including years,
month, days. When Start Time will be equal to computer’s system time, timer will
start to count.
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Font size (Font Size)
Font size can be selected directly by using parameter Font Size.
Make the necessary settings and select Exit or press √ in the lower right
corner of main clock’s window.

Layer settings
Clock is assigned to a layer by selecting layer on the comand line on the
top of editor‘s screen.
All layers are summed over
the alpha channel. Layer 0 has the
lowest priority, and Layer 3 - the
highest. Titles, effects and control of
each layer are independent of the
other layers.

Setting time (Set Time…)
Select a function Set Time... in menu Clock or simultaneously press the
"Alt" and "T" to set the time. Fill the box Time to set the time and press √. Time
setting does not change the computer’s system time.

Timer‘s Stop/Start (Timer)
You can stop and start the timer by using the menu function Timer in
menu Clock. If the timer, at the moment to go on air, must to counts, then set (•)
Move or simultaneously press the "Alt" and "F12". In case, you start timer on air,
value must to be (•) Stop or simultaneously press the "Alt" and "F11".
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OPTIONS
Setup
To set the parameters, select the menu function Setup in menu Options.
Setup dialog box opens to enter parameters.
Box Max Count of Recent Files field - is the maximum number of
projects that have been previously opened and shown in the menu File.
Clear - clears the list of projects that are shown in the menu File.

Field’s Live Video setting:
Enable (√) - to turn on the video source that is connected to the
video capture card;
Settings - setting video capture card’s parameters and size and
position of live video windows. Set input device, video size (720x576) and format
of video signal (Composite, S - VHS, ...) and other parameters required for
capture card.
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Network Settings parameter Time (ms) of repeated connection used
when data are obtained from other processing programs (statistic software) and
are transmitted by TCP/IP protocol. If, during the broadcast, the data transfer is
terminated, the connection will be resumed by intervals, valued in this parameter.
√ Confirm Window Close - ask confirmation when template is closed;
√ Use the buffer for video files - parameter, used to buffer animation
files into RAM when playing *.tga or *.png sequences in frames. Remember, this
parameter delayed on air appearance of title. Delay in duration is equal to the
frame Buffer Size parameter. Useful to eliminate HDD reading speeds distortion
in Windows.
Stop Wait & out - user defined shortcut cancel show last frame and
process next operation (when STOP TIME is Wait).
Manual start Field - user defined shortcut start show first frame (when
START TIME is Wait).
Make the necessary settings and press √ in the lower right corner of
setup window. To exit from the Setup without changes select Esc or .

Setting text encoding (Encoding)
Function Encoding in menu Options is used to convert data, received
from database text records.
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Global field data setting (Data Setup)
Data Setup function is used to input and change data around the page
(project) with the fields of the same name. This makes work much easier because
you can change the fields data in a single entry for the whole project in Data Setup
table.
Eg., a field with the name TeamHome is set with value
“BARCELONA" in the DataSetup table. All the fields with the name TeamHome
fills by record BARCELONA on the air.
Select the Data Setup function in the Options menu or simultaneously
press the "Alt" and "D".
Data properties:
Run - Yes: automatically start scanning for data changes (necessary
only when the Source is with real time changing data);
- No: get data only just at the loading moment.
Field Name - field name, created with the software Textus Editor;
Source - the source of information. It can be a text file, database, www
page, network, etc.;
Data Name - data source name;
Record - record number, if the source is with a table-type data structure
(DBF, TXT, ...);
Value - a data value for the all fields with the name FieldName.

New - insert the new line in the list;
Delete - delete the line from the list;
Load - load new data file with format *.xml;
Save As - saving data file (.xml) with new name;
Refresh - update changes in the list;
Close - closing a window Data.
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Set the color of the screen (Screen Color…)
Function Screen Color in menu Options is used to set desired
Textus Live software‘s screen color.

On air effects
All effects are available only for static titles.
1. Cut – immediately on air for all static titles;
2. Mosaic – appearing by accidental square dots. Parameter define dot
size (smallest - 4, biggest - 128);
3. Blinds – appearing by verticals strips. Parameter define strips width
(thinnest - 4, thickest - 128);
4. Wipe In – wipe in effect;
5. Wipe Out – wipe out effect;
6. Wipe Up – wipe up;
7. Wipe Down – wipe down.
Fast – Slow – speed of effect.
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Function keys (Help)
Function keys speed up your work. You can use them to cause some
major and frequently used functions, without going into the menu. To see function
keys press Keyboard shortcuts… in menu Help or press F1.
F4 – load file;
F5 – clock on air;
F6 – next template‘s window;
F8 – read data from the database into the active window. This function
does not work, if the window is in the automatic reading mode of data;
F9 – on/off all layer’s title on air;
Alt+A – active window on air;
Alt+Z – redraw title on air;
Alt+T – set time;
Alt+P – title‘s preview screen;
F11 – On/Off LiveVideo1;
F12 – On/Off LiveVideo2;
Alt+F11 – stop timer;
Alt+F12 – start timer;
Ctrl+F4 – close template‘s window;
PgUp – increase value by 1 of template’s record data;
Ctrl+PgUp – increase value by 2 of template’s record data;
Alt+PgUp – increase value by 3 of template’s record data;
PgDn – decrease value by 1 of template’s record data;
Ctrl+PgDn – decrease value by 2 of template’s record data;
Alt+PgDn – decrease value by 3 of template’s record data;
Alt+Space (default) – user defined shortcut cancel show last frame and
process next operation when STOP TIME is -1 (Stop Wait & Out);
Alt+D - global field data setting;
Alt+F – user defined shortcut start show first frame when START TIME is
Wait (Manual start Field);
Ctrl+Alt+T (on the Setup window). Additional Remove First Pixel
function;
Alt+X – quit TEXTUS LIVE software.
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Abbreviations, database records (FootballStatistic)

Menu

Description

Goal

Goal

Own Goal

Goal in the
home gate

Default
keyboard
shortcut
(Inc/Dec)
G/Ctrl+G

Team.DBF
Field

GOAL

Total.DBF
Field

GOAL

OWNGOAL

Red card

R/Ctrl+R

REDCARDS

REDCARDS

Yellow card

Y/Ctrl+Y

BOOKINGS

BOOKINGS

Blow in gate

T/Ctrl+T

SHOTSGOAL

SHOTSGOAL

Blow by gate

B/Ctrl+B

SHOTSWIDE

SHOTSWIDE

Shots on
Goal

Blow in gate

F5/Ctrl+F5

TSHOTSGOAL

Shots Wide

Blow by gate

F6/Ctrl+F6

TSHOTSWIDE

Additional time

ADDTIME

Offside

Offside

F7/Ctrl+F7

Foul

Fouls

F8/Ctrl+F8

FOUL

Corners

F9/Ctrl+F9

CORNERS

No

Corners
Goal scorer
home
Goal scorer
quest
Possesion time
(Percent)
Possesion time
(Seconds)
Player number

Player

Player name

PLAYER

Team

Team name

TEAM

Player position

POSITION

Player/Team
picture file

PHOTO

Player/Team
picture
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OFFSIDE

GOALHOME
GOALAWAY
NUM-/NUM+

BALLTIME

NUM-/NUM+

BALLTIMES
NO
TEAM

LOGO
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Abbreviations, database records (BasketballStatistic)

Menu
shortcut
PF
AS
REB D
REB O
REB T
TO
ST
BS
FT A
FT M
FT %
2FG A
2FG M
2FG %
3FG A
3FG M
3FG %
PTS
%

NO
Player
Player

Description
Personal fouls
Assists
Defensive rebounds
Offensive rebounds
Total rebounds
Turnovers
Steals
Blocks
Free throws attempted
Free throws made
Free throws %
2-pointers attempted
2-pointers made
2-pointers %
3-pointers attempted
3-pointers made
3-pointers %
Points
%
Game points
Set team fouls to zero
Player No
Player Name
Team Name
Player Height
Player Position
Player played time
Performance Index
Rating
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Keyboard
shortcut
(Inc/Dec)
P / Ctrl+P
R / Ctrl+R
A / Ctrl+A
V / Ctrl+V
K / Ctrl+K
S / Ctrl+S
B / Ctrl+B
F5 / Ctrl+F5
F1 / Ctrl+F1
F6 / Ctrl+F6
F2 / Ctrl+F2
F7 / Ctrl+F7
F3 / Ctrl+F3

T /Ctrl+T
Ctrl+Alt+P

DBF Field (Team.DBF/ REZULT.DBF)
PRAZ / (PRAZ1 or PRAZ2)
REZ_P / (REZ_P1 or REZ_P2 )
AT_KP / (AT_KP1 or AT_KP2)
AT_KM / (AT_KM1 or AT_KM2)
REB_T / (REB_T1 or REB_T2)
PER_K / (PER_K1 or PER_K2)
KLAID / (KLAID1 or KLAID2)
UZB_M / (UZB_M1 or UZB_M2)
TASK_1 / (TASK_11 or TASK_12)
TASK_1P / (TASK_1P1 or TASK_1P2)
PROC_1 / (PROC_11 or PROC_12)
TASK_2 / (TASK_21 or TASK_22)
TASK_2P / (TASK_2P1 or TASK_2P2)
PROC_2 / (PROC_21 or PROC_22)
TASK_3 / (TASK_31 or TASK_32)
TASK_3P / (TASK_3P1 or TASK_3P2)
PROC_3 / (PROC_31 or PROC_32)
TASK / (TASK1 or TASK2)
PROC / (PROC1 or PROC2)
/ (TASK1 or TASK2)
/(PRAZ1 or PRAZ2)
NR
VARDAS
/ (VARDAS1 or VARDAS2)
UGIS
AMP
MIN
ANK
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Digital clock over network
Virtual digital clock software provides a clock on air with the ability to
have required font and attributes. Virtual digital clock is synchronized manually
according to game‘s clock in the hall. You do not need clock camera in this case.
Structure is as below:

Several parameters required to insert digital virtual clock on the page:
 Name – used type of virtual digital clock software, e.g. DSBasketClock
Source – source address, e.g. tcp://@127.0.0.1:3199
Value – received value, e.g. 00:00
Record – time record on the selected clock protocol, e.g. 14
Software NetworkData configuration:
DigiSport Clock
Textus Basket Clock

- virtual clock type

Source 3
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TCP/IP Address - address which is connected by NetworkData software
to get clock’s info, e.g. 192.168.2.10:3216
Listen Port - port number. Must be the same as in prepared field, e.g.
3199
TextusLive is sending for the NetworkData pocket "Test $D$A" to check
network connection every 2 sec.
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Vilniaus g.215/15, LT-76348 Siauliai
Lithuania
Tel./fax +37041525930
mob.tel.+37068786167
e-mail: info@textus.lt
www.textus.lt
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